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Basic Installation
This section provides the basic steps in a typical installation of Minitab Express.

To install Minitab Express, follow the steps below. To renew an existing installation that has reached or is close to
reaching its expiration date, see Renewing licenses on page 12.
1. Designate authorized users of multi-user licensing web pages (optional).

2. Determine installation configuration.

3. Create license files at the multi-user licensing web pages.

4. Obtain software.

5. Install software.

Note This installation guide applies only to the multi-user installation for Minitab Express.

Step 1: Designate authorized users of multi-user
licensing web pages
To access the Minitab multi-user licensing web pages so that you can create the license files for the installation, you
must be either the Minitab License Coordinator for your organization or an authorized user.

At the time of purchase, someone from your company was designated as the Minitab License Coordinator. That person
has permission to log in to the Minitab multi-user licensing web pages to create license files. In addition, your company
can have other authorized users.

If you are not sure whether you're an authorized user, contact your organization's Minitab License Coordinator. Only
the License Coordinator can request additional authorized users by contacting a Minitab sales representative or Minitab
Technical Support.

Step 2: Determine installation configuration
All multi-user installations require Minitab License Manager, the software that manages Minitab Express based on the
information in the license file. Minitab License Manager must be installed in a configuration that allows it to communicate
with Minitab Express.

You can choose from several different installation configurations to suit your needs. For example, you can install Minitab
License Manager on a server in a networked configuration. In a networked configuration, users access the license file
on the server; therefore, each client computer does not need to be permanently assigned to a separate license file.
Another option is to install Minitab License Manager and Minitab Express on each client computer in a standalone
configuration, which requires a separate license file for each client computer.

The installation configuration you choose affects the number of license files you need to create and the installation
procedures that you need to follow. See Installation Configurations on page 7 for detailed information that will help
you to determine the best configuration for your organization.

The Minitab License Manager can run on either OS X or Windows operating systems and serve licenses to both
platforms. If you already have Minitab License Manager installed on a Windows server, ensure that you have the latest
version to be compatible with Minitab Express licenses.
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Step 3: Create license file(s)
You need at least one license file for installation. To create license files, you use the Minitab multi-user licensing web
pages. One license file per server is required in a networked installation. One license file per workstation is required in
a standalone configuration. See Installation Configurations on page 7 for more information on networked and
standalone configurations.

You need the following information to create a license file:

• The maximum number of simultaneous users that will be served by the license. In a standalone configuration, the
maximum number of users is 1 for each license. To determine the number of users in a networked configuration,
see Number of license files on page 10.

• The MAC address of each computer that will host a license. This is a unique identifier assigned to internal network
interface adapters (for example, Ethernet or Wi-Fi) installed on your computer.

To obtain the MAC address:

• From the Apple menu, select System Preferences.

• Select Network.

• From the left sidebar, select the network interface that you are using. Select either Ethernet or Wi-Fi.
Note Do not select Thunderbolt Ethernet or USB Ethernet because they are external adapters whose MAC address will not work.

• Click Advanced on the bottom right.

• Select the Hardware tab.

• The MAC address for the network interface will be displayed in the form: xx:xx:xx:xx:xx:xx. For example,
3c:09:3a:6c:18:ac. When you create your license file, enter the MAC address without the formatting characters;
remove colons or dashes (for example, 3c093a6c18ac).

For information on how to obtain a computer's MAC Address, see
https://support.minitab.com/installation/frequently-asked-questions/license-fulfillment/locate-my-computers-mac-address/

To create license files
1. Go to https://it.minitab.com/support/licensing/multi-user/customer-entitlement-summary.aspx.

2. Log in as an authorized user.

3. Complete the necessary steps to create the license file(s).

Step 4: Install software
Install Minitab Express and Minitab License Manager based on the installation configuration that you determined in
step 2. You can install Minitab License Manager on a server in a networked configuration or on each client computer
in a standalone configuration.

System requirements
You can find the latest system requirements for Minitab Express and the Minitab License Manager at
https://www.minitab.com/products/express/system-requirements/.
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To install in a networked configuration
1. Ensure that you have administrative privileges to install Minitab License Manager on the server and Minitab Express

on each workstation.

2. Ensure that the license file is available on the server (for example, in the Downloads folder). See Create License
File(s) on page 5 for more information.

3. Install Minitab License Manager on the server. You will be asked to select the license file during the installation.
The installation process creates a copy of the license file in /Library/Application Support/Minitab/LicenseManager.

4. Delete the license file or save the file in the event that you need to reinstall the Minitab License Manager at a later
time.

5. Install Minitab Express on each workstation.

• You need to specify the name or IP Address of your Minitab License Manager server during installation.

• Minitab Express chooses the first available port between 27000 and 27009. If your License Coordinator specified
a different port within the license file, check Specify port number, and enter that port number.

To install in a standalone configuration
1. Ensure that you have administrative privileges to install Minitab License Manager and Minitab Express on each

workstation.

2. Ensure that the license file is available on the workstation (for example, in the Downloads folder).

3. Install Minitab License Manager on each workstation. You will be asked to select the license file during the installation.

4. The installation process creates a copy of the license file in /Library/Application Support/Minitab/LicenseManager.

5. Delete the license file or save the file in the event that you need to reinstall the Minitab License Manager at a later
time.

6. Install Minitab Express on each workstation.

• When prompted for the name of the Minitab License Manager, enter @localhost.

• Minitab Express chooses the first available port between 27000 and 27009.
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Installation Configurations
The previous section explained how to install the multi-user version of Minitab products. This section provides a more
in-depth explanation of the client-server model and the possible installation configurations.

Multi-user installation
The multi-user versions of Minitab products are based on a client-server installation model. Minitab Express (the client
software) is installed on individual workstations. Minitab License Manager (the server software) is installed on a server.
Every time the client software is started, it communicates with the server to ensure that a license is available.

Typically, Minitab License Manager is installed on a single server. The client software can be installed on an unlimited
number of workstations. Minitab License Manager ensures that the number of concurrent users never exceeds the
licensed number of seats.

For example, an organization purchased 100 licenses of Minitab Express and configured Minitab License Manager to
control all 100 licenses. Minitab Express was installed on 300 workstations. Even though the client software has been
installed on 300 workstations, Minitab License Manager will allow only 100 instances of the client software to run
concurrently.

When the client software is started, it requests a license from Minitab License Manager. If a license is available, it is
sent to the client and the software starts successfully. If a license is not available, an error message is displayed.

Configuration options

Networked configuration
To set up a networked configuration, install Minitab License Manager on a server. A license file is requested during
the installation process. You need to provide the license file that was created during the procedure detailed in Basic
Installation. Minitab License Manager is installed to /Library/Application Support/Minitab/LicenseManager. The
installation program makes a copy of the license file, places it in the installation directory, and names the file minitab.lic.

The Minitab License Manager installation creates OS X daemons called "minitab" and "lmgrd". These license manager
services start automatically when they are installed and will remain running even if the system is rebooted. When the
daemon starts, it checks the Minitab License Manager installation directory for the license file. If the license file is valid,
the daemons start successfully.

Install the client software, Minitab Express, on as many workstations as necessary. During installation, you need to
provide the name of the server or IP Address on which Minitab License Manager is installed.

Standalone configuration
In a standalone configuration, Minitab products do not depend on accessing a network server. Instead, the Minitab
License Manager server software is installed on the same workstation as the client software, Minitab Express. Minitab
License Manager starts two daemons that are required to run on each standalone workstation. When Minitab Express
starts, it checks the Minitab License Manager service that is on the same workstation, regardless of network connectivity.
An individual license file must be created for each workstation.
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Mixed configurations
You can use a combination of networked and standalone configurations. For example, you can install Minitab Express
on 20 workstations that are connected to the network and also install Minitab Express on 5 standalone workstations
that are not connected to the network.

For information on mixed installation configurations and license files, see Number of license files on page 10.

Minitab License Manager
All multi-user installation configurations require the installation of the Minitab License Manager, the server software
that manages the use of Minitab Express. The Minitab License Manager ensures that the number of concurrent users
does not exceed the licensed number of seats, based on the information in the license file.

The Minitab License Manager service starts its daemons automatically when you install it. However, you may need to
restart the Minitab License Manager service in some cases, such as when you make changes to the license file. You
can restart the Minitab License Manager through several ways.

To re-run the Minitab License Manager installer
This approach works well if you have a new license file. Simply re-run the License Manager installer and select the new
license file when prompted. The install process will copy the license file to the correct location and restart the License
Manager.

To manually restart the Minitab License Manager
This approach works if you edit or replace the license file in-place. You need to be logged in as an administrator and
ensure that the file permissions and owner are maintained.
1. Navigate to /Library/Application Support/Minitab/LicenseManager.

2. Edit or replace the license file.

3. Double-click the Restart LicenseManager. command script (in the same folder). It will restart the License Manager,
which will cause it to read in the new license file. You will be prompted to enter your password.

To uninstall the Minitab License Manager
To uninstall the Minitab License Manager:
1. Navigate to the /Library/Application Support/Minitab/LicenseManager area.

2. Double-click the LicenseManager_Uninstall.pkg file.

3. This will shut down the license manager server components and delete associated files.
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License Files
License files are required for the installation of Minitab multi-user products. This section provides general background
information on license files, including what they are, where they are created and stored, and how they are used.

Using license files

What is a license file?
A license file is a text file named minitab.lic. The file does not have a .txt extension, but you can open it in a standard
text editor. If you edit the license file, ensure that you do not change file types, character sets, or formats. The license
file contains information about the licenses that your organization purchased. This information includes the expiration
date, the number of licenses, and the computer's MAC address.

After you create a license file at the Minitab multi-user licensing web pages, save it to the computer on which you will
install the Minitab License Manager, the server software that manages the use of Minitab Express based on the
information in the license file.

Sample license file

SERVER this_host 0A1B2C3D4E5F
VENDOR minitab
USE_SERVER
PACKAGE Minitab_Suite minitab 1.1 COMPONENTS="Minitab:19 \

minitabexpress:1" OPTIONS=SUITE SIGN="08D7 41DE B6CF 4131 2330 \
5C94 7F1D F544 3DF4 BAE3 C11C 5FC9 D03D 3B43 D803 14B8 4A50 \
D1AC ADCC 4CD7 E7AF E4F7 907A DCD1 556B E7D2 4708 D941 B1CD \
8615" SIGN="08D7 41DE B6CF 4131 2330 5C94 7F1D F544 3DF4 BAE3 \
C11C 5FC9 D03D 3B43 D803 14B8 4A50 D1AC ADCC 4CD7 E7AF E4F7 \
907A DCD1 556B E7D2 4708 D941 B1CD 8615"

INCREMENT Minitab_Suite minitab 1.1 01-dec-2020 100 DUP_GROUP=UH \
SUITE_DUP_GROUP=UH ISSUER=Minitab SIGN="0A06 A210 1374 7941 \
4BDF 55B7 49C0 388C BD51 2A31 2D7D 253B AB1A 4B55 CC41 1F44 \
1F66 B62A 03C7 4FB5 2D80 1A74 342F 5C7C 18A4 E471 0945 5795 \
D5FE D9E7"

In the sample license file above, the terms in bold specify the following information:

0A1B2C3D4E5F
The unique MAC address of the computer for which this license file was created.

Minitab:19 minitabexpress:1
The name of the product for which the license file was created.

01-dec-2020
The expiration date of the license file.

100
The number of users allowed to concurrently run Minitab.

Each license file is created for a single computer. The computer is identified in the license file by its MAC address. The
license file cannot be used on a computer that does not have its MAC address specified in the license file.
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The Minitab Express product is sold as a Suite, which allows users to access Minitab Express as well as Minitab 19. The
license file will contain a Package line and an Increment line for the Minitab Suite product. When the Minitab Express
client software is launched and a license is checked out from the server, a license for Minitab 19 is also checked out
for that client.

How license files are used
During the installation of Minitab License Manager, you need to provide the license file. The License Manager will
create a copy of the license file in /Library/Application Support/Minitab/LicenseManager. The Minitab License Manager
service is then installed. The service reads the license file and then starts.

Note After you install Minitab License Manager, you can delete the license file.

Authorized users can create license files at the Minitab multi-user Licensing web pages. See Create License Files on
page 5 for more information.

Number of license files
You need one license file for each Minitab License Manager that you install. In a typical networked configuration,
Minitab License Manager is installed on a single server. In this case, only one license file is needed. For example, Minitab
License Manager is installed on a single server that will serve all 100 licenses. You need to create a single license file
for all 100 seats.

You can also divide your licenses among multiple servers, if desired. For example, Minitab License Manager is installed
on two servers, one for 75 users in Department A and the other for 25 users in Department B. This installation
configuration requires two license files: one file for 75 seats and another file for 25 seats.

In a standalone configuration, Minitab License Manager must be installed on each workstation. As a result, a unique
license file is required for each installation of Minitab License Manager. For example, a small computer training lab
has 10 computers that are not networked. You need to install Minitab Express and Minitab License Manager on all 10
computers. This installation configuration requires 10 license files, one for each computer.

You can have a combination of networked and standalone installations. You need to create a single license file for the
server and a separate license file for each standalone workstation. For example, an organization purchases 100 licenses
for Minitab Express. They want 10 standalone installations in the computer lab. A single server will host the remaining
90 licenses. This installation configuration requires 11 license files: one for the server and one for each of the 10
standalone workstations.

Adding a second product or additional users to your
license file
When you purchase both Minitab Express and Companion, you must initially create two separate license files at the
multi-user licensing web pages, one for each product. However, to install both products, you need to merge the two
license files into one file. After you download both license files, append the contents of one license file to the other
license file.

You can also add additional users to your license, which also involves appending the contents of your new license file
to the existing file.

To append an additional product to a license file
You need to be logged in as an administrator to perform the following steps.
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1. At https://it.minitab.com/support/licensing/multi-user/customer-entitlement-summary.aspx , create a separate
license file for the additional product.

2. Save the new license file. Do not overwrite the existing license file in /Library/Application
Support/Minitab/LicenseManager.

3. Open the new license file for the additional product in a text editor.

4. Copy everything from the INCREMENT line down.

5. Close the new license file.

6. Open the original license file in /Library/Application Support/Minitab/LicenseManager in a text editor.

7. Paste the copied contents of the new license file to the end of the original license file.

8. Save the license file.

9. Double-click the Restart License Manager.command script file. You may be prompted to enter your password. The
script will restart the license manager. See To manually restart the Minitab License Manager on page 8 for more
information.

10. To verify your changes:

• Open a terminal window.

• Type the following command: lmutil lmstat -c "/Library/Application Support/Minitab/LicenseManager/minitab.lic"
-a

Example of a license file with appended product

SERVER this_host 0A1B2C3D4E5F
VENDOR minitab
USE_SERVER
PACKAGE Minitab_Suite minitab 1.1 COMPONENTS="Minitab:19 \

minitabexpress:1" OPTIONS=SUITE SIGN="08D7 41DE B6CF 4131 2330 \
5C94 7F1D F544 3DF4 BAE3 C11C 5FC9 D03D 3B43 D803 14B8 4A50 \
D1AC ADCC 4CD7 E7AF E4F7 907A DCD1 556B E7D2 4708 D941 B1CD \
8615" SIGN="08D7 41DE B6CF 4131 2330 5C94 7F1D F544 3DF4 BAE3 \
C11C 5FC9 D03D 3B43 D803 14B8 4A50 D1AC ADCC 4CD7 E7AF E4F7 \
907A DCD1 556B E7D2 4708 D941 B1CD 8615"

INCREMENT Minitab_Suite minitab 1.1 01-dec-2020 DUP_GROUP=UH \
SUITE_DUP_GROUP=UH ISSUER=Minitab SIGN="0A06 A210 1374 7941 \
4BDF 55B7 49C0 388C BD51 2A31 2D7D 253B AB1A 4B55 CC41 1F44 \
1F66 B62A 03C7 4FB5 2D80 1A74 342F 5C7C 18A4 E471 0945 5795 \
D5FE D9E7"

INCREMENT companion minitab 5 01-dec-2020 8 VENDOR_STRING="limited \
term, limited users, borrowing enabled" DUP_GROUP=UH \
ISSUER=Minitab ISSUED=01-dec-2018 BORROW=26280 \
NOTICE="Customer ID: 01234 License Coord ID: 56789 \
RENI01234" SN="STDORD31415 01234INC" START=01-dec-2018 \
SIGN="1EA6 00D1 E785 EEA9 F026 63B5 BBA0 B8B0 CAB9 \
91CA A57A D123 D9DD 0372 A1CD 136F 12F4 ABCB EA0A 3AD9 A71F \
F014 7B78 A683 6EB2 FCC6 9685 0D66 6355 441C"

To append additional users to a license file
You need to be logged in as an administrator to perform the following steps.

1. At https://it.minitab.com/support/licensing/multi-user/customer-entitlement-summary.aspx, create a separate
license file for the additional users.

2. Save the new license file to your system. Do not overwrite the existing license file in /Library/Application
Support/Minitab/LicenseManager.
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3. Open the new license file for the additional users in a text editor.

4. Copy everything from the INCREMENT line down.

5. Close the license file.

6. Open the original license file in /Library/Application Support/Minitab/LicenseManager in a text editor.

7. Paste the copied contents of the new license file to the end of the original license file.

8. Save the license file.

9. Double-click the Restart License Manager.command script file. You may be prompted to enter your password. The
script will restart the license manager. See To manually restart the Minitab License Manager on page 8 for more
information.

10. To verify your changes:

• Open a terminal window.

• Type the following command: lmutil lmstat -c "/Library/Application Support/Minitab/LicenseManager/minitab.lic"
-a

11. Look for the line that includes Total of x licenses issued and confirm that x is equal to the total number
of licenses (original + added).

Example of a license file with appended users

SERVER this_host 0A1B2C3D4E5F
VENDOR minitab
USE_SERVER
PACKAGE Minitab_Suite minitab 1.1 COMPONENTS="Minitab:19 \

minitabexpress:1" OPTIONS=SUITE SIGN="08D7 41DE B6CF 4131 2330 \
5C94 7F1D F544 3DF4 BAE3 C11C 5FC9 D03D 3B43 D803 14B8 4A50 \
D1AC ADCC 4CD7 E7AF E4F7 907A DCD1 556B E7D2 4708 D941 B1CD \
8615" SIGN="08D7 41DE B6CF 4131 2330 5C94 7F1D F544 3DF4 BAE3 \
C11C 5FC9 D03D 3B43 D803 14B8 4A50 D1AC ADCC 4CD7 E7AF E4F7 \
907A DCD1 556B E7D2 4708 D941 B1CD 8615"

INCREMENT Minitab_Suite minitab 1.1 01-dec-2020 16 DUP_GROUP=UH \
SUITE_DUP_GROUP=UH ISSUER=Minitab SIGN="0A06 A210 1374 7941 \
4BDF 55B7 49C0 388C BD51 2A31 2D7D 253B AB1A 4B55 CC41 1F44 \
1F66 B62A 03C7 4FB5 2D80 1A74 342F 5C7C 18A4 E471 0945 5795 \
D5FE D9E7"

PACKAGE Minitab_Suite minitab 1.1 COMPONENTS="Minitab:18 \
minitabexpress:1" OPTIONS=SUITE SIGN="08D7 41DE B6CF 4131 2330 \
5C94 7F1D F544 3DF4 BAE3 C11C 5FC9 D03D 3B43 D803 14B8 4A50 \
D1AC ADCC 4CD7 E7AF E4F7 907A DCD1 556B E7D2 4708 D941 B1CD \
8615" SIGN="08D7 41DE B6CF 4131 2330 5C94 7F1D F544 3DF4 BAE3 \
C11C 5FC9 D03D 3B43 D803 14B8 4A50 D1AC ADCC 4CD7 E7AF E4F7 \
907A DCD1 556B E7D2 4708 D941 B1CD 8615"

INCREMENT Minitab_Suite minitab 1.1 01-dec-2020 3 DUP_GROUP=UH \
SUITE_DUP_GROUP=UH ISSUER=Minitab BORROW=26280 SIGN="019C 819E \
D67F 1253 CAF3 5DE5 824D 433E 5365 B022 C549 8E67 50E2 3912 \
1692 1549 A7F9 353F 1211 91CF 31A0 D80D 95FF B5E2 D5C5 C0FB \
14E2 429E EFCC B734"

Renewing licenses
To avoid "checkout failed" error messages that are caused by expired license files, renew your organization's Minitab
Express license before it expires.

1. Your organization's License Coordinator must purchase a new license for your organization.
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2. An authorized user must log in and generate new license files at
https://it.minitab.com/support/licensing/multi-user/customer-entitlement-summary.aspx. See Step 3: Create license
file(s) on page 5 for more information about creating license files.

3. Restart the Minitab License Manager installer and select the new license file when prompted.

Note License files are created with an expiration date. Minitab Express will not start if the license is expired.
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Advanced Topics

Checking for updates
Minitab Express automatically checks for updates every month and gives each user the ability to manually check for
updates at any time.

To manually check for updates
1. Open Minitab Express.

2. Choose Minitab Express > Check for Updates.

3. Follow the instructions for installing the update.

License manager utility
Flexera Software provides the lmutil utility for performing license management tasks. This utility can be found in:
/Library/Application Support/Minitab/LicenseManager.

Lmutil is a command line tool that must be run in a Terminal window. For more information about lmutil, refer to the
FlexNet Publisher License Administration Guide distributed by Flexera Software LLC. Detailed instructions can be found
in the "Using License Administration Tools" section.

You can use this utility to check the status of Minitab License Manager and to help you monitor network licensing
activities, such as the number of licenses in use and who is using them. You can also review configuration settings.
See Check Minitab License Manager status and settings on page 18 for more information.

Specifying ports
Minitab Express uses two ports for communication between the workstation and the server: the license manager
(lmgrd) port and the vendor daemon (minitab) port. You can modify the license file to specify which port numbers
Minitab Express should use.

Specifying ports manually is useful when you need to identify them as open ports on firewalls. When communication
appears to be blocked, configure these open ports on any firewall on or between the workstation and server, including
software firewalls such as Mac OS X firewall. See FLEXnet error 96 on page 20 for more information.

You can specify both the license manager and vendor daemon ports in the same license file. Make a backup of your
license file before you edit it.

To specify a license manager port
The license manager (lmgrd) automatically chooses the first available port between 27000 and 27009 each time the
Minitab License Manager service starts. You can set this port number to a permanent value.

You need to be logged in as an administrator to perform the following steps.
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1. Open the license file in /Library/Application Support/Minitab/LicenseManager in a text editor.

2. Type the port number after the MAC address on the first line. Leave a space between the MAC address and port
number, as shown in the example below.

3. Save the file.

4. Restart the Minitab License Manager service to re-read the license file. See To manually restart the Minitab License
Manager on page 8.

5. To verify your change, open the Minitab License Manager log file, out.txt, which is located at /Library/Application
Support/Minitab/LicenseManager/log, in a text editor.

6. Locate the line that includes lmgrd tcp-port.

7. Make sure that the port number on this line is correct. For example, lmgrd tcp-port 27001.

Example of license file with specified license manager port of 27001:
SERVER this_host 0A1B2C3D4E5F 27001
VENDOR minitab
USE_SERVER
PACKAGE Minitab_Suite minitab 1.1 COMPONENTS="Minitab:19 \

minitabexpress:1" OPTIONS=SUITE SIGN="08D7 41DE B6CF 4131 2330 \
5C94 7F1D F544 3DF4 BAE3 C11C 5FC9 D03D 3B43 D803 14B8 4A50 \
D1AC ADCC 4CD7 E7AF E4F7 907A DCD1 556B E7D2 4708 D941 B1CD \
8615" SIGN="08D7 41DE B6CF 4131 2330 5C94 7F1D F544 3DF4 BAE3 \
C11C 5FC9 D03D 3B43 D803 14B8 4A50 D1AC ADCC 4CD7 E7AF E4F7 \
907A DCD1 556B E7D2 4708 D941 B1CD 8615"

INCREMENT Minitab_Suite minitab 1.1 01-dec-2020 16 DUP_GROUP=UH \
SUITE_DUP_GROUP=UH ISSUER=Minitab SIGN="0A06 A210 1374 7941 \
4BDF 55B7 49C0 388C BD51 2A31 2D7D 253B AB1A 4B55 CC41 1F44 \
1F66 B62A 03C7 4FB5 2D80 1A74 342F 5C7C 18A4 E471 0945 5795 \
D5FE D9E7"

To specify a vendor daemon port
The vendor daemon (minitab) port is dynamically assigned from a wide range of port numbers each time the Minitab
License Manager service starts. You can set this port number to a permanent value.

You need to be logged in as an administrator to perform the following steps.

1. Open the license file in /Library/Application Support/Minitab/LicenseManager in a text editor.

2. Type port= and the port number at the end of the second line ("port" is case-sensitive). Leave a space between
minitab and port=.

3. Save the file.

4. Restart the Minitab License Manager service to re-read the license file. See To manually restart the Minitab License
Manager on page 8.

5. To verify your change, open the Minitab License Manager log file, out.txt, which is located at /Library/Application
Support/Minitab/LicenseManager in a text editor.

6. Locate the line that includes minitab using TCP-port.

7. Make sure that the port number on this line is correct. For example, minitab using TCP=port 3000 .

Example of license file with specified vender daemon port of 3000:
SERVER this_host 0A1B2C3D4E5F
VENDOR minitab port=3000
USE_SERVER
PACKAGE Minitab_Suite minitab 1.1 COMPONENTS="Minitab:19 \
minitabexpress:1" OPTIONS=SUITE SIGN="08D7 41DE B6CF 4131 2330 \
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5C94 7F1D F544 3DF4 BAE3 C11C 5FC9 D03D 3B43 D803 14B8 4A50 \
D1AC ADCC 4CD7 E7AF E4F7 907A DCD1 556B E7D2 4708 D941 B1CD \
8615" SIGN="08D7 41DE B6CF 4131 2330 5C94 7F1D F544 3DF4 BAE3 \
C11C 5FC9 D03D 3B43 D803 14B8 4A50 D1AC ADCC 4CD7 E7AF E4F7 \
907A DCD1 556B E7D2 4708 D941 B1CD 8615"

INCREMENT Minitab_Suite minitab 1.1 01-dec-2020 3 DUP_GROUP=UH \
SUITE_DUP_GROUP=UH ISSUER=Minitab BORROW=26280 SIGN="019C 819E \
D67F 1253 CAF3 5DE5 824D 433E 5365 B022 C549 8E67 50E2 3912 \
1692 1549 A7F9 353F 1211 91CF 31A0 D80D 95FF B5E2 D5C5 C0FB \
14E2 429E EFCC B734"

Options file
You can use the options file to control various license system options for the Minitab License Manager, such as reserving
or excluding licenses for a person or group.

To use an options file
You need to be logged in as an administrator to perform the following steps.

1. Open a new file in TextEdit.

2. Change the file format to plain text. Choose Format > Make Plain Text.

3. Type your settings with the appropriate syntax, as documented in the FlexNet Publisher License Administration
Guide distributed by Flexera Software LLC. See the bottom of this topic for an example options file.

4. Choose File > Save... and browse to the same folder as minitab.lic (/Library/Application
Support/Minitab/LicenseManager/Log).

5. In Save As, type minitab.opt.

6. Click Save.

7. Restart the Minitab License Manager service. See To manually restart the Minitab License Manager on page 8.

8. To verify that the options file is successfully implemented, open the Minitab License Manager log file, out.txt, at
/Library/Application Support/Minitab/LicenseManager in a text editor.

9. Locate the line that includes Using options file:<path_to_options_file>. If this text is present, the
options file has been successfully implemented.

If a minitab.opt file is present, the Minitab License Manager service reads it and implements the settings in the file.

In the example below of an options file, line 1 prevents the user tjones from using Minitab Express. Line 2 creates a
group named "quality" and defines members of that group. Line 4 reserves three licenses for the quality group.
EXCLUDE minitabexpress USER tjones
GROUP quality jsmith bmiller awilson
RESERVE 3 minitabexpress GROUP quality

Customizing your deployment
For detailed instructions on customizing the deployment of Minitab Express, see the Deployment Guide for Minitab
Express at
https://www.minitab.com/uploadedFiles/Documents/install-guides/Minitab_Express_Deployment_Guide-EN.pdf.
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Troubleshooting
This section provides information for troubleshooting problems related to licensing and installing Minitab products.

Log files
Minitab Express and Minitab License Manager each generate log files or write to system log files. These log files can
be used for troubleshooting.

Installation log file
The installation process writes log information to the Console application. In the left pane, look under FILES > /var/log
and select install.log.

Update log file
Minitab Express update operations will write error information to a log file. This information will go into one of two
logs:

• ~/Library/Logs/SparkleUpdateLog.log

◦ You can also access this log information in the Console application. In the left pane, choose FILES >
~/Library/Logs, then select SparkleUpdateLog.log.

• Console log

◦ Under SYSTEM LOG QUERIES, select All Messages.

To isolate the log messages:
1. Open the Console application.

2. Select the associated log area.

3. Select Clear Display from the title bar.

4. Perform the update operation.

5. The log will show messages associated with the update operation.

Minitab License Manager log file
Minitab License Manager is the server software that controls the use of your license. It generates a log file that is
updated with events, such as license check-ins, check-outs, and error messages. The log file is named out.txt and is
located at /Library/Application Support/Minitab/LicenseManager/Log.

To read the Minitab License Manager log file, open it in a text editor.

To reset the size of the Minitab License Manager log file (for example, when it gets too large), restart the Minitab
License Manager. For more information, see To manually restart the Minitab License Manager on page 8

Note For detailed information on the Minitab License Manager log file, refer to the FlexNet Publisher License Administration Guide
distributed by Flexera Software LLC.
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Check Minitab License Manager status and settings
You can check the status of Minitab License Manager to help you monitor network licensing activities, such as the
number of licenses in use and who is using them. You can also review configuration settings.

1. Create a new Terminal window.

2. To navigate to Minitab License Manager folder, type:
cd/Library/Application\Support/Minitab/LicenseManager.

3. Type the following command: lmutil lmstat -c minitab.lic -a

4. You will see a list of the licenses that are available and currently in use.
Note You may also be able to enter the following command in a Terminal window, from any location, to see the same information:
lmutil lmstat -a

For example, if you have 50 total licenses and 33 are in use, you will see this information:

Users of minitabexpress: (Total of 50 licenses used; Total of 33 licenses in use)

Specific details about each license are also listed:

jsmith LAB MAC (v1.0)(LAB MAC/27000 302), start Fri 3/1 4:15

jsmith is the user name, LAB MAC is the computer name, and 27000 is the license manager port.

FLEXnet license errors
You may encounter several types of FLEXnet error messages that indicate that you cannot check out a license. These
messages are formatted in general as follows:
FLEXNET License Error Number: Error text.

For example:
FLEXNET License Error -97-121-0: Check out failed

Some of the errors that you may encounter are listed below. For a complete list of possible error codes, see the FlexNet
Publisher License Administration Guide.

FLEXnet error 15
ExplanationPossible cause

The server name that was provided during the installation
of Minitab Express on the client computer is used to locate
that server on the network. Make sure that the server name
is valid. For instructions on locating the server name, see
https://support.minitab.com/installation/frequently-asked-
questions/minitab-license-manager/change-default-
location-where-minitab-companion-look-for-license-
manager/.

The server name that was provided during the installation
of Minitab Express on the client computer is not valid.

18

Minitab Express for Mac Troubleshooting

https://www.minitab.com/uploadedFiles/Documents/license-management/FlexNetLicenseAdminGuide.pdf
https://www.minitab.com/uploadedFiles/Documents/license-management/FlexNetLicenseAdminGuide.pdf
https://support.minitab.com/installation/frequently-asked-questions/minitab-license-manager/change-default-location-where-minitab-companion-look-for-license-manager/
https://support.minitab.com/installation/frequently-asked-questions/minitab-license-manager/change-default-location-where-minitab-companion-look-for-license-manager/
https://support.minitab.com/installation/frequently-asked-questions/minitab-license-manager/change-default-location-where-minitab-companion-look-for-license-manager/
https://support.minitab.com/installation/frequently-asked-questions/minitab-license-manager/change-default-location-where-minitab-companion-look-for-license-manager/


FLEXnet error 25
ExplanationPossible cause

The license file that is managed by Minitab License
Manager supports some other Minitab product. To resolve
this, you need to create a new license file for Minitab
Express.

You are using Minitab Express with an invalid license file.

FLEXnet error 34
ExplanationPossible cause

If the date difference is greater than 24 hours, Minitab
License Manager will refuse to grant the license. Reset the
clock on the client computer.

The date differs in excess of 24 hours between the client
computer and the Minitab License Manager server.

FLEXnet error 68
ExplanationPossible cause

Not all licenses are borrow-enabled. Borrow-enabled
licenses will have "borrow-enabled" within the text of the
license file.

The license file is not configured to allow for borrowing.

FLEXnet error 92
ExplanationPossible cause

The MAC address in the license file must match the MAC
address of an enabled network adapter on Minitab License
Manager. See License Files on page 9 for more
information.

The MAC address in the license file does not match the
MAC address of the Minitab License Manager server.

FLEXnet error 95
ExplanationPossible cause

Your license type may not support this method. In the Find
License dialog box, instead of choosing Specify the
License File, choose Specify the License Server System.
Type the server name. For example, type @localhost.

You are browsing to a license file in a standalone
configuration.
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FLEXnet error 96
ExplanationPossible cause

The client computer must be able to communicate with
the Minitab License Manager server over two ports: the
Minitab License Manager (lmgrd) port and the minitab
vendor daemon (minitab) port. You can use Network Utility
to test communications. See the Minitab License Manager
log file on page 17 to determine which port numbers are
used. See Specifying ports on page 14 to manually
configure ports.

Firewalls or network configurations are blocking
communications between the client computer and the
Minitab License Manager server.

The Minitab License Manager service must be running to
process license requests for Minitab Express.

The Minitab License Manager service is not running on the
license server.

FLEXnet error 97
ExplanationPossible cause

The MAC address in the license file must match the MAC
address of an enabled network adapter on Minitab License
Manager. See License Files on page 9 for more
information.

The MAC address in the license file does not match the
MAC address of the Minitab License Manager server.

The expiration date for your license is specified in the
license file. Minitab Express is not usable after the
expiration date. See License Files on page 9 for more
information.

The license expired.

The network adaptor card must be enabled for the Minitab
License Manager server to verify the MAC address. Without
this, Minitab Express cannot start. This issue is most
commonly encountered with laptop computers that may
change the status of a network card under various
conditions.

The network adaptor on the Minitab License Manager
server is disabled.

You can make a few valid changes to the license file, such
as specifying a port number. Most other changes will
corrupt the license file, making it unusable to Minitab
License Manager.

The license file was modified.

Minitab Express installations are sensitive to the computer's
date.

The date is incorrect on the computer that runs Minitab
License Manager software.

The Minitab License Manager service must be running to
provide license requests for Minitab Express.

The Minitab License Manager service is not running on the
license server.

Multiple FLEXlm license managers may be running on this
server, which caused the Minitab License Manager to use
a different port. See To specify a license manager port on
page 14 to manually configure ports.

Minitab License Manager is using a different
communication port than expected.
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Minitab License Manager fails to start
The Minitab License Manager service may fail to start. You can use the Activity Monitor app to check if the daemons
are running:
1. Run the Activity Monitor application (for example, type Activity Monitor into Spotlight).

2. Select View > All Processes to show all processes.

3. Click the Process Name header in the list to sort the results by process name.

4. Look for processes titled lmgrd and minitab. Both should be running. There may be multiple lmgrd processes
running, depending on what other apps are on your system.

If the processes are not running, look in the Console log for any error messages that occurred during startup. You can
also run the Restart License Manager command script in /Library/Application Support/Minitab/LicenseManager to
attempt to restart the license manager processes. Also, view the Console log at this time to look for errors.

ExplanationPossible cause

Minitab License Manager expects the license file to be in
/Library/Application Support/Minitab/LicenseManager. If
the license file is not in this location, re-install the Minitab
License Manager. You will be prompted for your license
file again.

The license file (minitab.lic) is not in the installation
directory.

The license file must be named "minitab.lic" (unless this
default value was modified later). Make sure that the file
is not named minitab.lic.txt (a common mistake). Confirm
that the file does not end with .txt.

The license file is not named correctly.

Some text editors may add unwanted content to your file.
Also, make sure the file was not saved as a rich text
document or that unnecessary UTF-8 characters were not
added to the file.

Extra text is in the license file.

For best results, install Minitab License Manager to a
computer with only ANSI characters in its name.

Minitab License Manager server has non-ANSI characters
in its name.
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Web site errors

Access Denied
If you try to log in to the Minitab multi-user license management web pages and you are not an authorized user, the
Access Denied error message may appear. For more information, see Step 1: Designate authorized users of multi-user
licensing web pages on page 4.

Unable to Proceed: Entitlements Not Available
If you log in to the multi-user license management web pages to create license files and there are no valid orders for
your organization, the message Unable to Proceed: Entitlements Not Available appears. Contact your
Minitab Sales Representative.

Online resources
The following online resources are available:

• Troubleshooting solutions at https://support.minitab.com/installation/

• The latest downloads for Minitab multi-user products at https://www.minitab.com/downloads/

• The latest documentation for Minitab multi-user products at https://www.minitab.com/support/documentation/

• The FlexNet Publisher License Administration Guide at
https://www.minitab.com/uploadedFiles/Documents/license-management/FlexNetLicenseAdminGuide.pdf
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